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Spreadsheet models are a natural tool for managers but they can be
hard to create from scratch and hard to understand and use

if they're not well constructed.

This short guide provides tips on how to create a well-designed
worksheet and also discusses some auditing techniques.

Specific references are to Excel 2000.

-Paula Ecklund
Spring 2001
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I. Getting Started

Before you begin building a worksheet, spend some time thinking about the data you're going
to model and the problem you want to solve. Try to identify the inputs and outputs and the
relationships among the data.

Inputs

Known Values
Any known values or given data. These are quantities you don't control. Do you
need any additional data to build the model?

Decision Variables

Quantities you control and can manipulate to optimize your model's solution. In
some cases, decision variable values may be efficiently optimized by using tools
like Excel's Solver.

Outputs

The Object
What you're trying to solve, find, show, or optimize: the "bottom line".

Any Constraints
Limits to inputs or outputs, tradeoffs, conditions you must meet. Examples of
constraints are budgetary limitations or limits to available resources.

Relationships

Relationships Between Variables

Relationships between the known values and decision variables, expressed in
formulas. Not all the relationships may at first be clear, especially in a complex
problem. They may become more clear as you work through the development of
your model.

A Pattern

Whether or not your problem fits into a "family" of problems for which you
might employ a generic model structure. For example, problems dealing with
resource allocation or scheduling have traditional formats you might want to
adopt for your model.



II. Data Entry and Organization

Organize your spreadsheet model around your data. Start building the model by entering the
data you know about. You don't necessarily need to know just how you're going to use all the
data before you enter it. At the start, just get the data into the spreadsheet. Excel makes it easy
for you to change things around later if you need to.

Constant values

If possible, keep all constant values together in one area of the worksheet, clearly
distinguished from decision variables and formulas. An important principle of good
spreadsheet design is to keep just one copy of each constant value. That is, enter a
constant value in only one location in the worksheet. Then if you use the value in
another cell, use a cell reference that refers to the constant value's unique location.

Example: You enter the constant value of 6% for sales tax in cell E5. When you write a
formula in your worksheet that requires sales tax, reference E5 in the formula instead of
"hard coding" in the 6% value. Do: =subtotal*E5

Don't: =subtotal*6%

Better yet, assign cell E5 a name, like SalesTax. Then use that name in any formula you
write. The formula in the example above would then read =subtotal*SalesTax.
Row-Column Structure

Are there existing row or column structures in the data that you can exploit in your

model's layout? For example, the data for the worksheet below was available in a
tabular format that translates directly into this useful model layout.

A [B] ¢ [ o | e | F [ 6 [ W [i] J ]

| 1 |Oak Products, Inc: Optimum Product Mix Finder

2
13 | Product: Captain Hate AmHi AmLo SpanK Spanil

4
|9 | ProfittUnit: $36 540 545 536 $35 $25

6

Starting

17| Product Resources Requirement Inventory
| 8 | Longdowel ] 0 12 0 g 4 1280
| 9 | Short dowel 4 12 0 12 4 g 1900
110 | Leg 4 4 4 4 4 4 1080
| 11| Heavy seat 1 0 0 ] 1 1 190
|12 | Light seat 0 1 1 1 0 0 170
113 | Heavyrung B 0 4 ] =) 0 1000
|14 | Light ung 0 4 0 5 0 6 1000
115 | Captain rail 1 0 0 0 0 0 110
| 16 | Hate rail 0 1 1] 0 0 1] 72
| 17 | American rail 1] 0 1 1 0 a 93
| 16 | Spanish rail 0 0 0 0 1 1 g5
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The Final Report

Give some thought at the start to what you might want a final report or reports to look
like. What quantities should be computed and displayed in the reports? What's the most
logical way in which to arrange them? What will the reports' readers be looking for? Is
there information that should appear together on a single page? Do readers your readers
need the option of seeing underlying formulas?

Documentation

General Documentation:
In an obvious place in the worksheet include general information that describes what
the model is for, where the data is from, who the output is going to, etc.

Documenting Data:
When entering data, use descriptive labels to document data items.

Example:
A | B
1 |Sales Tax B%
Inflation g.20%

Not only can you include labels as text in worksheet cells, you can also name cells or
groups of cells (ranges) and use those names in place of row-column references. This
can make your worksheet much easier to read and modify.

Rules for naming a range:
¢ A range name can be of any length but can't contain spaces, commas, or
hyphens.
¢ A name must start with an underscore or a letter and shouldn't look like a cell
reference.

Examples of valid range names:
Cost.of .Goods
_Old_Data
LongName1234
OK1

Examples of invalid range names:
Cost-of-Goods
Old Data
LongName 123
Al



Here are three methods for naming a range:

Method One: Use Insert, Name, Create to create

names for cells automatically based on their

Create Hames in——
[T Top Row row or column headings. Select the range to
[¥ Left Column name and issue the commands to get this

[ Bottom Row dialog box and idicate where Excel should
[ Right Column | Help I find the names to use.

Method Two: Use Insert, Name, Define to create a name for a range you specify.
For example, if you select the range A1:B3 in the

example at right and issue the Insert, Name, Define A | B
command, Excel presents a dialog box that assumes [ 1 [Jan 11
you want to name the entire range Jan. If this isn’t 2 |Feb 34
what you want, you can change the current 3 |Mar 55
selection.

Method Three: Use the name box on the Excel 5 formula bar.

g\

In the example here you might highlight A1:B2, then X

click in the part of the formula bar that now holds A | B

the cell reference Al and type in a name for the 1 [Jan 11

range, like Constant_data. 2 |Feb 34
13 |Mar 55

Documenting a Single Cell:

If you want to document a cell Bl ETRIen {8 = BTy

but don't want to display the @ File Edit Wiew Insert Format Tools Data Mindow Help = |@|

documentation directly in a i

cell of the worksheet, use a _ T

comment. A comment is Dﬁn|%@.ﬁy|éﬁﬁ_‘g|“*“' (2)

associated with a cell, but not B1 | =

part of it. e 3
1 |Tax rate: B% “Paula Ecklund:

To create a comment, select 2 This is & comment about J

the cell in question and enter 3 EZﬁ anllUE it raxrate b

the commands Insert, 4 e

Comment. Excel displays a 5 g =l

small text box in which to - -

enter the comment. [ 4» bl Sheet1  Sheetz [ sheeta /|i4] | LlJJ

e i e




Select Tools, Options and then the View tab to see your options regarding how comments
are displayed. You can choose to display no comments, the comment indicator only (a
red triangle at the upper-right-hand corner of a cell with an associated comment), or
both the indicator and its comment.

If you have the first (no comments) option selected, you can still see what cells have
comments associated with them by hitting F5 (which opens the Go To dialog), hitting the
Special button, selecting “Comments”, and hitting OK. Exel selects every cell that has an
associated comment.

If you have the second (comment indicator only) option selected, Excel shows the text of
the comment when you position the mouse pointer over the indicator.

The Sheet tab on the Page Setup dialog lets you select how you want comments printed:
Not at all, as displayed on the worksheet, or all together at the end.

Page Setup Ed |

Page I Margins | Header Fooker Sheet |

Frint area: I :n_] BrirEt... |
Prink Litl
e Prinkt Presview |
Rows to repeat at top: I % |
Cpkions. ..

Columns to repeat at left; I :H //
Prink

[ aridlines [ Row and column headings

[ EBlack and white Comments:
[ Draft gualicy

Page order
% Do, then over EE B ETEE
L] K arC s [
" Cwer, then down 8 .2lE 3B

K I Zancel




III. Creating Formulas

Numbers in Formulas

Avoid using numbers (actual data) in formulas. Instead, use cell references that point to
data cells. By keeping a data item in a unique location in the worksheet you can much
more easily change the item and have the change affect the use of that item throughout
the worksheet.

Example:

Cell E5 holds the data item 6%, for tax rate.

In all formulas that need to reference tax rate, refer to cell E5 instead of typing in 6%. If
the tax rate later changes to 6.5% you can change the rate value one place in your
worksheet. The value changes in every formula that refers to that cell and you need not
locate and change every formula that uses the value.

Reproducing Formulas

You may often need to reproduce a formula in several places in a worksheet. In many
cases, you can type in the formula one time and then copy it to the other locations,
avoiding hard-to-detect typing errors. When copying formulas, be sure to understand
how to use relative and absolute addressing, described below.

Relative and Absolute Addressing

For copied formulas, Excel uses relative addressing as the default. That is, Excel adjusts
the cell references in your source formula when the formula is copied to new locations.

. A | B | ¢ [ D
The worksheet at right shows three 1 [Tax: cop
formulas in cells D4, D5, and D6. Because 2
of this model's layout, there's no need to 3 | Sales Jan Eeh Total:
type in three formulas. Type in just the 4 | Dept1 45 >3 555
tirst formula in cell D4 and then copy itto [ 5 Dept. 2 35 47 %30
cells D5 and Dé6. 6 Dept. 3 215} 85 $151




This view of the same A | B | € | D
worksheet shows the contents 1 |Tax: 0.05

of the formula cells. You can 2

see that for each copied 3 | Sales Jan Feh Total:
formula, Excel adjusted the cell 4 Dept. 1}45 23 =SUM(B4:C4)
references to refer to the data ] Dept. 2|35 42 =SUIM(BA:CE)
in the correct row. 6 Dept. 3|56 a5 =aUMIBE. CE)

However, there may be occasions when you want to override Excel's relative addressing
default. In the example below, the formula in the Tax column makes use of the values in
column D and the 5% value in cell B1.

A | B | ¢ [ Db | E
1 |Tax: 5%
2
3 Sales Jan Feh Total: Tax:
4 Dept. 1 45 23 atal $3.40
5 Dept. 2 35 42 Ha0 $4.00
6 Dept. 3 B e §151 57 55

This view of the spreadsheet shows how the formulas appear. In order to properly copy
the formula in E4 to cells E5 and E6, absolute addressing must be specified in the master
formula in cell E4 for the 5% tax figure.

A | B | C | D | E
1 |Tax: 0.05
2
3 Sales Jan Feh Total: Tax:
4 Dept. 1}45 23 =aUMB4A:C4) =DA™5EH
3 Dept. 2]35 42 =alUM(BS.CE)  =D5"5EH
6 Dept. 3J66 a5 =alUMBE:CE)  =DBE"§B%1

An absolute cell reference is indicated by putting a dollar sign before the row and
column reference. In this example worksheet, cell B1 holds the tax value. When the cell
reference is entered as $B$1 in a formula it indicates an absolute references to that cell.
As an absolute reference, the reference won't change when the formula containing the
reference is copied.

So when the master tax formula in cell E4 is copied down the column to cells E5 and E6,
the reference to the tax rate remains correct, pointing to cell B1. Note, however, that the
first cell references in the master tax formula (D4) is left relative. When it's copied in a
formula, it becomes D5 and D6, which is also correct.



Simple Formulas

Keep formulas simple and straightforward. This makes them easier to read and to
debug. If you need to exress complex relationships, create several formulas and use
them like building blocks instead of constructing an overly long formula.

Range Names

Use range names instead of cell references to make formulas easy to understand. (See
the discussion above on naming and applying ranges.) If you assign a name to a cell or
a range after you've used that cell or range in a formula, use the Insert, Name, Apply
commands to have Excel use the name in formulas place of a cell reference. If you want
the name to be used in place of any reference to that cell anywhere it might appear in
the worksheet, select a single cell before issuing the commands. If you want the name
applied to only a particular range, select that range before issuing the commands.

Example:
Formula without range names applied: =C10*A3
Formula with range names applied: =Subtotal*Tax

Intermediate Quantities

Arrange your model to show intermediate quantities of interest, such as subtotals.

Flow of Calculation

Try to plan the arrangement of worksheet formulas and labels so the flow of
calculations is obvious.



IV. Auditing and Debugging Your Worksheet

See the Organization of a Large Worksheet

Zoom
Use the commands View, Zoom to get the dialog box at

HE|

right. Then specify how you want Excel to display your | adneation =

worksheet on the screen. If you ask for a low |t :

magnification (say 25 or 50%) you'll be better able to S Cancel

review your worksheet layout. Then return to regular

o . . s
100% magnification to continue working. 2

Ral-8
" Fit selection

f* Cuskom: illillil L '

€ zop% L_.?l(.......j
_ Concel |

View Detailed Information About Cells

Excel includes a number of tools that provide information about cells on a worksheet:

e The Auditing Toolbar

You can locate the cells that supply data for formulas and find cells that depend on
values in other cells by using the Auditing toolbar. To display the Auditing toolbar,
point to Auditing on the Tools menu, and then click Show Auditing Toolbar.

Customize ;

Toolbars i Commands ; Ciptions i

Toolbars;

v Worksheet Meno Bar - e, ,,
[ chart Menu Bar -
v Standard Rename...

Or, click Tools, Customize to
open the “Customize” dialog
box like the one at left. Locate
the entry for the Auditing

EELIRE
Dielete
Liglete

(]
=
o
=
—_-

? Reviewing E toolbar and click the box to its
Farms L B L :

[ stop Recording left to toggle it on.

™ External Data Lz Attach. .

7 E More on using the Auditing
I Full Screen Toolbar below.

[ Circular Reference
[ visual Basic

I web _:_j




e Cell Comments

You may find it useful to add comments to a cell, to include some documentation about
a value or formula directly in the worksheet. Add a comment by right-clicking the cell
and selecting Insert Comment. A comment box displays that works like the standard text
box. View a comment by pointing to the cell that has the comment attached. Comments
can be printed, either where the comment appears on the worksheet or at the end of the
worksheet.

¢ Cell Formatting

To see the formatting applied to a cell, click the cell, and then click Cells on the Format
menu. You can review each tab in the Format Cells dialog box to see the formats applied
to the cell.

e Cell/Range Name

If you need to know whether a name refers to a cell, click the cell. The Name box at the
left end of the formula bar displays either the address of the cell, such as A1, or the
name that refers to the cell.

Use Excel's Auditor to Correct Problems and Examine Cell Relationships

Turn on the Auditing Toolbar with the commands Tools, Auditing, Show Auditing
Toolbar. Use the tools on the Auditing toolbar to locate problems and display cell
relationships.

For example, a circular reference occurs when a formula mistakenly

refers to itself and thus can't be resolved. Click the problem cell and use

the Trace Error button on the Auditing Toolbar to locate the error.

Click the cell whose dependents or precedents you want to locate and
use the trace precendents or trace dependents icons on the Auditing
Toolbar. Excel draws arrows on the worksheet to show relationships
between cells. Use the erase precedent arrows icon or the erase
dependent arrows icons to erase the arrows when you're through.

n

HE
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V. For More Information

Excel has extensive online help with a variety of access methods. You can get online
help from within dialog boxes, via the menus, or courtesy of the Office Assistant.

For example, the “Paste

Function” dialog box displays

a help button. Choose
whatever function you're

interested in and then click the

help button to open
information about that

function in the online help.

If your Office Assistant is turned on, click the Help Button on the Standard
Toolbar (or hit F1) to “open” it. Then click the Office Assistant cartoon
character to open a space in which to type a question or

what would you like to do?

Type your question here, and

Paste Function Ed |

Function category: Function name:

Maost Recently Used

all

Financial

Date & Time

Math & Trig
Skatiskical

Lookup & Reference
Database

Text S
Logical MEDIAMN

Information LI ;I

RANK{number,ref,order)

Returns the rank of a number in a list of numbers: its size relative to other
values in the lisk,

@l (0]4 I Zancel |

term you want help with. Depending on the state of your

spreadsheet when you invoke the Office Assistant, the

then click Search,

Assistant may suggest some relevant help topics.

If you don’t want to see the Office Assistant in the workspace, right-

Opti Search
= \ =2 click and choose Hide.
If you don’t want to use the Office Assistant at all, right-click and
choose Options to open the Office Assistant options dialog. Then
toggle off the “Use the Office Assistant” option.
Tip: Right click the Office Assistant and choose Animate to see the
Assistant’s repertoire of tricks.

11



EHE
Gallery  Cphions |

—— P ¥ Use the Office Assistant

[ Respond to FL ke ¥ Move when in the way
% Help with wizards [ Guess Help topics
W Display alerts W mMake sounds

[ Search for both product and programming help when programming

Show tips about
W Using features more effectively [ only show high priority tips
W Using the mouse more effectively [ Show the Tip of the Day at startup

[ Kevboard shorkouks Resek my tips |

Cancel |

While the Office Assistant can be amusing and sometimes helpful, Excel 2000 has a
much-improved online help system that’s worth getting to know. You can invoke it by
turning off the Office Assistant and choosing the commands Help, Microsoft Excel Help.

E3 Microsolt Excel - ExcelReviewDemo_xls | Microsoft Excel Help =10 x]
@ File Edit Wiew Insert Format Tools Data Financial
& 8 R aR =] i
IDER[SRsy|[smra I —
Inelex: f o =
| - - Cortents | Arswerizsrd | | ways to get assistance while you work
= This tapic provides reference information about:
Rectangle 2 =] [ R a—— pic p
(] | H | | | J | K | I Asking for Help from the Office Assistant
1 Getting Help from the Help rmenu
5 Clgar | | Zearch | Getting Help from the Office Update Web site
3 2, @ direme s Finding out what's new in Excel 2000
F] _operator = More information
5 5 4
[ Spank Spani ’;S;WU‘ Asking for Help from the Office Assistant
7 L] 0 I ANAME? Type a question When you have a question about a Microsoft Office
8 Total Profit AMULL! _I program, you can ask the Office Assistant, For example, to get Help
#REF! s about how to format a chart, type How do I format a chart? in the
] 35 525 $10’294 Assistant balloon. '
£ — Get Help automatically The Assistant automatically provides Help
Starting Total 3 o b (0 found) topics and tips on tasks you perfarm as you work — before you even
11 pment Inventory = Usage  -ose & tapic (I Fadn ask a question. For example, when you set up a worksheet for printing,
the Assistant provides you with topics that help you prepare the
12 i 4 1280 1280 -
= worksheet for printing.
13 4 8 1900 1900,
EfR 4 4 1090 1080 Display helpful tips The Assistant also displays tips on how to use
| 15 1 1 190 100 the features in Microsoft Excel more effectively. Click the light bulb @ =
16 0 0 170 165 next to the Assistant to see a tip.
17 5 0 1000 760 Customize the Assistant “You can also select a different Assistant
18 u] 5] 1000 E53 and set it to operate so that it fits your personality and the way you
19 i} 0 110 100 work, For example, if you pre_fer using the k_egrbaard to using the
e mouse, you can have the Assistant display tips on shortcut keys,
ﬂ a o 72 72 Because the Assistant is shared by all Office programs, any options you
21 o 0 93 93 change will apply to the Assistant in your other Office programs as well.
22 1 1 85 0 Return to kop
23
24 Getti
L& | etting Help from the Help menu
£ Display and use the Help window lust click Microsoft Excel
| 26 Help on the Help menu. If the Assistant is turned on, it appears. If the
27 Assistant is turned off, the Help window appears. To type a gquestion in
28 the Help window, click the Answer Wizard tab, To scroll through a
s LEY_: table of contents for Help, click the Contents tab, When you want to
4|« v [l Hemesin Caks }Copy Sheet { Fill&Extend search for specific words or phrases, click the Index tab,
J Draw - [% G} futoshapes » ~ a [] O “ Display ScreenTips To see a ScreenTip for a menu command,
Ready | ,—,7 toolbar butto_n, or soreen _regiun, click w_h._at's This? on the Help ﬂ
iﬂSlalll @ Exploring - Caralynl | Fs Inbox - Netscape Folder | Microsoft Excel - ExcelRey. | @ 2001 ExcelE fliciencieston.. |M<ﬂ£ﬂ@.¢)=§’ 2:45 PM
ﬁDuke University-The Fugu... | @ Document3 - Microsoft Worc”@ Microsoft Excel Help
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Excel’s complete online help system displays in two windows: A navigation (subject)
pane left and a topic (content) pane at right. The topic pane or both the topic and
navigation panes can be open on top of the current worksheet, making it easy to follow
online help instructions as you work.

Microsoft Excel Help

=101

Use the arrow icons
at the upper left to
control the display
of the navigation
pane.

There are three

entrances into online

help: “Contents”,
the “ Answer
Wizard”, or the
“Index”.

Underlined
references in the
topic pane are
hyperlinks.

Drag to expand the
panes to whatever
size suits you.

W - 2 S

Contents I Ansywver Wizard  Index |

1. Type keywords

Ways to get assistance while you work
This topic pravides reference information about:

Asking for Help from the Office Assistant

Getting Help from the Help menu

Clgar || Search I

Getting Help from the Office Update Web site

2. Or choose keywords

|_operator ﬂ

#
#DIV/O!
#na
#MAME?
#MULL!

#REFI hd|

3. Choaose a topic {0 Found)

Finding out what's new in Excel 2000

Maore information

Asking for Help from the Office Assistant

Type a question ‘When vou have a question about a Microsoft Office
program, you can ask the Office Assistant, For example, to get Help
about how to format a chart, type How do 1 format a chart? in the
Assistant balloon,

Get Help automatically The Assistant automatically provides Help
topics and tips on tasks you perform as you work — before you even
ask a question. For example, when you set up a worksheet for printing,
the Assistant provides you with topics that help you prepare the
warksheet for printing.

Display helpful tips The Assistant also displays tips on how to use

the features in Microsoft Excel more effectively. Click the light bulb @
next to the Assistant to see a tip.

Customize the Assistant You can also select a different Assistant
and set it to operate so that it fits your personality and the way you
work, For example, if you prefer using the keyboard to using the
mouse, you can have the Assistant display tips on shorteut keys.
Because the Assistant is shared by all Office programs, any options you
change will apply to the Assistant in your other Office programs as well.

Return to top

Getting Help from the Help menu

Display and use the Help window Just click Microsoft Excel
Help on the Help menu. If the Assistant is turned on, it appears. If the
Assistant is turned off, the Help window appears, To type a question in
the Help window, click the Answer Wizard tab. To scroll through a
table of contents for Help, click the Contents tab. When you want to
search for specific wards or phrases, click the Index tab,

Display ScreenTips To see a ScreenTip for a menu cornmand,
toolbar bu!:to_n, or SCreen region, click w_h§t's This? on the Help

|»

=
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